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Audio interface and control surface

Functions of the audio interface and control surface

This section explains how to connect the unit with a computer and how to set up and 
use the audio interface and control surface functions of the  with a DAW and other 
software.

 Control surface functions

Control surface functions can be used 
to control DAW software on a computer 
via USB. Transport operations, including 
playback, recording and stopping, and 
physical control of the DAW faders are 
possible. Furthermore, various other DAW 
software functions can be mapped to the 
F1~F5 keys (assignable functions depend 
on the DAW used).

DAW software

Cubase LE, etc.

Windows/Mac

USB Cable

 PHONES jack
Playback device like 
headphones or an 
audio system

OUTPUT jacks
Stereo system,
speakers with built-in 
amplifiers, etc.

INPUT jacks
Guitars and other 
musical instruments,
built-in stereo mic

Audio driver

プラグのイメージ

 Audio interface

The  inputs and outputs can be used 
as a Hi-Speed USB 2.0 audio interface 
with 2 inputs and 2 outputs at quality 
up to 24-bit/96kHz. Effects can be used 
when the sampling rate is 44.1 kHz, and 
the unit can be powered by a computer’s 
USB bus.

コンピューターから　　を操作
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 Multifunction tuner

In addition to standard chromatic tuning, 
the on-board multifunction tuner also sup-
ports 7-string guitar, 5-string bass and 
various drop tunings.

 Comprehensive built-in mixer

Using the  mixer, you can make a 
mix for monitoring. When simultaneously 
recording guitar and vocals, for example, 
you can adjust volume balance, panning 
and reverb levels.
Moreover, you can also adjust the balance 
between the built-in mixer and the sound 
sent from a computer.

 Versatile effect functions

Built-in insert effects can be applied to 
specific channel paths, and two-types 
of send/return effects work via the mixer 
send/return. These effects can be applied 
when recording, of course, but they can 
also be applied to only the monitor output. 
For example, when recording vocals, you 
can apply reverb only to the monitor signal 
to make singing easier.

 Supports input from a variety of 
sources, including guitars, mics and 
line level instruments

The two onboard jacks include one high-
impedance input. Both accept XLR and 
standard phone plugs and can provide 
phantom power (24 or 48V). 
Many sources are supported from high-
impedance guitars and basses to dynamic 
and condenser microphones and line-
level devices like synthesizers. In addition, 
the built-in high-performance condenser 
microphones are convenient for recording 
acoustic guitars and vocals.
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❶ ❷

Cubase LE installation overview

By using the  between a computer and 
external audio devices and instruments, their 
signals can be recorded using a DAW or other 
software. Instruments and mics that require 
high impedance or phantom power can also 
be connected.

Using the faders and keys on the , you 
can control transport operation and mixing in 
digital audio workstation (DAW) software on 
your computer.

To use the  with DAW software, after installing that software, an audio driver must 
be installed and set to recognize it.* We explain how to do this with Cubase LE. 

Install DAW software

Install driver

ZOOM R8 audio driver* 

	 Audio interface setup	

	 Connect R8 to computer	  P.8

Device setup

	 Control surface setup 	 P.10, 30~

ZOOM R8 audio driver 

Mackie Control

DAW software setup

Cubase LE

❶ Audio interface ❷ Control surface 

Recording	 P.16

Reference: "Cubase LE Startup Guide" 

Reference: "Cubase LE Startup Guide" 

Reference: "Cubase LE Startup Guide" 

*No driver is necessary for use with Macintosh computers.



7

A
u

d
io

 interface m
anu

al 

 audio interface system requirements 

Please refer to the Cubase LE Startup Guide 
for detailed instructions on installing the ZOOM 

 audio driver and Cubase LE.

 audio interface  
system requirements 

Cubase LE Startup guide

Windows
Windows® XP SP3 or later (32-bit)
Windows® Vista SP1 or later (32-bit, 64-bit)
Windows® 7 (32-bit, 64-bit)
32-bit: Intel® Pentium® 4 1.8 GHz or faster 
64-bit: Intel® Pentium® Dual Core 2.7 GHz or faster 
32-bit: RAM 1 GB or faster 
64-bit: RAM 2 GB or faster 

Intel Mac
OS X 10.5.8 or later/10.6.5 or later
Intel® Core Duo 1.83 GHz or faster 
RAM 1 GB or faster 

Both
USB 2.0 compatible port

•	 USB hubs are not supported.
•	 Intel® chipsets recommended. 

Note about descriptions and images
This manual was prepared based on use with  
Windows systems. Special functions related to Mac 
OS X are indicated separately. 

The screen images are of the Windows version of 
Cubase LE.

About trademarks
• The SD  and  SDHC logos are trademarks. 
• Windows®, Windows® XP, Windows Vista® and Windows 7® are registered trademarks of Microsoft® 

in the USA. 
• Macintosh® and Mac OS® are trademarks of Apple Inc. 
• Steinberg and Cubase are registered trademarks of Steinberg Media Technologies GmbH. 
• Intel® and Pentium® are trademarks of Intel Corporation. 
• Mackie Control is a registered trademark of LOUD Technologies. 
• Logic is a trademark of Apple Inc. 
• SONAR is a trademark of Cakewalk, Inc. 
• Ableton Live is a trademark of Ableton AG. 
• Digital Performer is a registered trademark of Mark of the Unicorn. 
• All other product names, registered trademarks, and company names mentioned in this documentation 

are the property of their respective owners.

In order to improve the product, specifications might be changed without advance notice.
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Connecting and disconnecting in audio interface mode
This is an overview of connecting and disconnecting the  to a computer with a USB 
cable. For details, see the included Cubase LE Startup Guide guide. 

Connecting the  to a computer 
for the first time

Install the Cubase LE DAW 
software on the computer.1 1

Press USB.Install the ZOOM  audio driver 
on the computer from the included 
SD card. (No driver is necessary for 
use with Macintosh computers.)

2

Press ENTER. 

Select AUDIO I/F.  

2

Press ENTER.

Select EXECUTE.  4

3☞ Reference: "Cubase LE Startup Guide" 

 setup and connection

Connect the  to the computer.3

 setup and connection 

 NOTE
•	 The ZOOM  audio driver is essential for 

using the  as an audio interface with DAW 
software such as Cubase LE. (No driver is neces-
sary for use with Macintosh computers.)

•	 Download the latest  audio driver from the 
Zoom Corporation website.

	 http://www.zoom.co.jp/

Device setup

Control surface setup	 P.10

Setup the DAW software.4
☞ Reference: "Cubase LE Startup Guide" 

Change 
menu

Change 
menu

Mackie Control

Connect the  to the computer 
using a USB capable.
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1

•	 The audio interface and control surface func-

tions of the  can be used by drawing power 
through a USB cable from the USB bus. 

•	 We recommend always using the latest  
system software. 

Press the  below 

Press ENTER.

Select YES.2

NOTE

Disconnecting

Select CONTINUE to use the same settings as last time.

• INSERT EFFECT settings

• SEND RETURN EFFECT settings 

• Mixer settings 

• TUNER settings 

Select RESET to restore default settings for each item.

Change 
menu

or press .
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Using control surface functions 
When using the  connected by USB as an audio interface, the  keys and faders 
can be used to control Cubase LE’s transport and mixer.

HINT
Assigning keys
For a list of functions that can be assigned to the 
knobs and keys of the , as well as other trans-
port/function keys that are supported by Cubase 
LE, please consult the “Control surface functions 
quick reference guide” in this manual.

About the control surface Control surface setup 

In control surface mode, the keys and knobs 
on the  can be assigned to particular 
Cubase LE functions.

5 Then, launch Cubase LE.

Transport section 	 P.11

About banks 	 P.12

Fader section 	 P.12

☞
Reference: Control surface functions quick 
reference guide P.15

6 From the Cubase LE “Devices” 
menu, select “Device setup…” 

Open the “Device Setup…” window. 

7 At the top left of the Device setup 
window [+], [−] and [|<] buttons 
appear. Click the [+] and select 
“Mackie Control”

8 Set the MIDI input and output

MIDI input:	 ZOOM R8 
MIDI output:	 ZOOM R8 

See  setup and connection on P.8-9
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Transport section 

By setting up the control surface, the  
transport section keys can be assigned to indi-
vidual functions in Cubase LE.

F1 key F5 keyF2 key F3 key F4 key

REW key  FF key STOP key PLAY key REC key

Rewind Fast
forward Stop Playback Record

HINT
You can connect a footswitch to the CONTROL IN 
jack to start and stop playback, and change effect 
patches, for example, with your foot when using the 

 as an audio interface.

☞
Reference:	 Operation Manual
	 Using a footswitch P.113
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Fader section operation 
Using the faders and status keys of the fader section, you can adjust the volume of 
corresponding Cubase LE tracks, mute and solo them, and arm them for recording.

Operating the fader section

1 Assign the Cubase LE tracks 
(channels) that you want to control 
to the fader section.

About banks 

After setting up control surface operation, the 
main parameters of Cubase LE can be oper-
ated using the  fader and status keys.

A group of tracks operated by the faders 
and status keys is called a “bank.” With the 

, one bank of 8 adjacent tracks can be 
controlled.
For example, if fader 1 is assigned to Cubase 
LE track 1, tracks 1-8 can be controlled as 
shown in the following diagram.

Status keys & 
Faders 1 2 3 4 5 6 7 8

Track Tr.1 Tr.2 Tr.3 Tr.4 Tr.5 Tr.6 Tr.7 Tr.8

As the diagram shows, when tracks 1~8 are 
selected, pressing  beneath  once 
switches the assignments as shown below.

Status keys & 
Faders 1 2 3 4 5 6 7 8

Track Tr.9 Tr.10 Tr.11 Tr.12 Tr.13 Tr.14 Tr.15 Tr.16

Push  beneath 
The next lower bank of eight tracks (channels) is as-
signed to the fader section. 

Push  beneath 
The next higher bank of eight tracks (channels) is 
assigned to the fader section.

2 Use the faders to control the 
volumes of the corresponding 
tracks.

The faders control the volumes of their re-
spective tracks. Change the master volume 
by moving the Master Fader.

3 To change the function of the 
status keys for all the tracks, 
press the soft key for the desired 
function.

Use these keys to set the 
functions of the status keys
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 level meters 
(Audio interface use)

Signal just before being 
sent to computer shown

Signal returning from 
the computer shown.

Checking DAW recording levels
Set “REC SIGNAL” (in the INSERT 
EFFECT menu) to set whether signals are 
sent to the computer “WET” (with effect) 
or “DRY” (without effect).

Adjust so that the 
level meters do not 
clip (reach 0 dB).

0 dB 
(clipping)
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Setting the function keys
The five keys above the transport keys can be used as function keys (F1~F5) and 
assigned as desired.

Function key setup

51 Open the “Device setup…” dialog 
in Cubase LE.

7 Press the “Apply” button. 

Choose the type of Cubase LE 
function from the Category pop-up 
menu. 

2 Commands can be assigned using the three 
columns displayed on the right side of the 
window.

Select “Mackie Control”.

3 From the “Button” column choose 
the function key (F1~F5) to be 
assigned a Cubase LE function.

6 Click on the “Command” column 
and select the desired Cubase LE 
function from the pop-up menu.

The items in this pop-up menu will differ 
depending on the category chosen.

4 Click on the “Category” column for 
that control.
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Control surface functions quick reference guide
These functions work with Cubase LE, Cubase, Logic Pro, SONAR, Ableton Live and 
Digital Performer. 

Control Explanation

Fader section 

Status keys Turns mute, solo or record arming on/off for tracks

1–8 faders Controls the volume of the corresponding tracks

MASTER fader Master volume operation 

Display section Soft keys
Change functions of status keys, change banks and end 
connection (EXIT)

Transport section 

Cursor keys Performs the same functions as the computer arrow keys1

DIAL Moves the project cursor position2

REW key Rewind

FF key Fast forward

STOP key Stop

PLAY key Play

REC key Record

AUTO PUNCH I/O key Depends on the F1 key setting

A-B REPEAT key Depends on the F2 key setting

 (marker) key Depends on the F3 key setting

 (marker) key Depends on the F4 key setting

MARK/CLEAR key Depends on the F5 key setting

1Scrolls window in Digital Performer
2No function in Digital Performer
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Recording with Cubase LE 
In this chapter, we explain how to record into Cubase LE using the .

Create a new project

Copy the ZOOM  project templates 
to the computer.

Launch Cubase LE.1

2 Choose “New Project” from the File 
menu.

The New Project Window where you can choose 
a new project template opens.

For Cubase LE 5, copy them as follows 
Windows
C:\Program Files\Steinberg\Cubase LE5
\templates
Macintosh
/Applications/CubaseLE5.app/Contents/
templates/

From the CubaseLE_template folder on the SD 
card included with the , copy the templates 
to the location where Cubase LE is installed.

3 Create a new project

If you have copied the  project tem-
plates to the designated folder, these project 
templates will be displayed when creating a 
new project. By choosing these templates 
you will be able to easily create projects with 
audio track input and output settings already 
made for the .

Template names and details

ZOOM R8 Mono Recording

Project with Cubase LE mono tracks 1–2 assigned 
to  INPUTS 1–2

ZOOM R8 Stereo Recording

Project with a Cubase LE stereo track assigned to 
 INPUTS 1–2
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NOTE
The inspector displays information about the track 
currently selected. If it does not display anything 
click on a track to see that track’s status.

Create a new audio track

5 Set-up the audio tracks that were 
made as follows.

The project file save location window is displayed.

4 Set the save location and click the 
“OK” button (“Choose” button on 
Mac OS X).

This will create a new project and the project 
window where most Cubase LE operations are 
conducted will open.

Inspector area allows detailed track settings

If the inspector is not shown, click 
here to show it (click again to hide it)

Select the track input/output bus.
The names of the  busses assigned in 
the VST Connections (Devices menu) will be 
displayed. 
Click here to choose a different bus from a menu 
that will appear.

To add a new audio track, select “Add Track” from 
the “Project” menu and then choose “Audio” from 
the sub-menu that appears.
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Recording With Cubase LE

HINT
When the Monitor button is orange, the audio track 
input level is displayed in the level meter next to 
the fader. When the Monitor button is off, the audio 
track output level is displayed.

Connect an instrument

6
Connect an instrument such as 
a guitar to an  INPUT jack and 
choose an effect patch.

The chosen effect patch will be applied to the signal 
and can be recorded on the computer via the USB 
port.

7 Select “Mixer” from the Cubase LE 
“Devices” menu.

The mixer window opens, showing the channels 
corresponding to the created tracks and the 
master channel.

☞ Reference: 
Operation Manual
Connections
Selecting effect patches

See the following for information about how to 
set the  input signal.

8 Enable track monitoring and 
recording.

Master Channel

Click the Monitor 
button until it appears 
orange.

Click the record enable 
button. It will appear 
red when recording is 
enabled.

Channel corresponding 
to an audio track

P.12

P.83
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NOTE
•	 If the Monitor button is on, the  input signal 

and the signal returning to the  via the 
computer will both be output from the  at 
the same time, creating a flanger-like sound.  
To monitor accurately while adjusting the 
recording level, turn the BALANCE knob to DIRECT.

 •	The meter above shows the signal level after it 
has been processed internally by Cubase LE. 
For this reason, a slight delay might occur from 
the time a string is plucked until the level meter 
moves. This is not a defect.

Adjust the recording level

9 While playing the instrument, 
adjust the  input level and set 
the Cubase LE recording level.

Check the recording level for Cubase LE by 
viewing the level meter of the channel that 
corresponds to the recording-enabled track. Set 
it as high as possible without making the meter 
peak.
When adjusting the level, do not move the Cubase 
LE fader, but instead adjust the  gain.

Level Meter

10

11

After adjusting the recording level, 
click the Monitor button so that it 
becomes grey.

Monitor 
button

This turns off display of the input level, and mutes 
the signal from the computer to the .

When the Monitor button is off, the signal just 
before it is sent to the computer can be monitored 
from the  PHONES and OUTPUT jacks.

Confirm that the Transport Panel is 
displayed.

If the Transport Panel is not displayed, select 
“Transport Panel” from the “Transport” menu.
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Recording with Cubase LE

Check the recording (playback)Recording

12 1Click the Record button on the 
Transport Panel to start recording.

Stop button

As you play the instrument, a recorded waveform 
is drawn in real time in the project window.
To stop recording, click the Stop button in the 
Transport Panel.

Lower the master channel fader.

2 Click the Go to Zero (|<) button in 
the Transport Panel to return to the 
beginning of the project.

Return to the beginning of the project

3 Click the Play button in the 
Transport Panel to begin playback.

Play button

Record button
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Tips to improve performance
When using Cubase LE, application perfor-
mance could become extremely delayed or 
error messages such as “cannot synchronize 
with USB audio interface” might be dis-
played. Should such things happen often, 
the following measures might improve the 
situation.

➊	 Quit other running programs.
In particular, confirm that many background 
applications are not running.

➋	 Reduce the use of plug-ins 
(effects, virtual instruments) 

in Cubase LE
If a large number of plug-ins are running, the 
computer processing capacity might not be 
able to keep up. In addition, reducing the 
number of simultaneous playback tracks 
might be effective.

If the sound breaks up, please increase the 
audio Buffer Size (Devices > Device Setup… 
> R8 driver > Control panel).
For details, see Step 5 of the Cubase LE 
Startup Guide.
Moreover, if the application performance 
is extremely slow and regular computer 
operation is affected, we recommend quit-
ting Cubase LE and disconnecting the  
USB port from the computer once, and then 
reconnecting the USB port and relaunching 
Cubase LE.

Check the recording (playback)

HINT
If no sound comes out after clicking the Play button 
following recording, recheck the VST Connections 
(step 6 in the Cubase LE Startup Guide).
In addition, confirm that the  BALANCE control is 
set to the center.

4 Raise the master channel fader to a 
suitable playback level.
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Importing audio into Cubase LE
By connecting a computer and the  with a USB cable and setting the  to 
function as a card reader, you can import audio data as WAV files into Cubase LE audio 
tracks. 

Importing by drag & drop

4 Launch Cubase LE.

6 Open the  SD card from the 
computer and open the “AUDIO” 
folder of the project from which you 
want to import audio data.

5 Open the Cubase LE project into 
which you want to import audio 
data.

1 Connect the computer and the  
with a USB cable.

2 Press USB.

Press Enter.

3 Select READER.  

コンピューターからR24を操作

Change 
menu

Access the  from the computer.
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In the “Import Options” window 
click the “Copy Files to Working 
Directory” check box, and click 
the OK button. 

7 9Select the file (or files) that you 
wish to import from the “AUDIO” 
folder and drag and drop them 
into the Cubase LE project 
window.

When a file is dragged and dropped, 
a window will open asking how 
Cubase LE should place the file.

When dragging multiple files at 
one time, select either “Different 
Tracks” or “One Track” as the 
import method.

8
Generally, select “Different Tracks” to automatically 
create one track for each file. The files will be ar-
ranged vertically in the project window. 
Select “One track” to create one track with the 
audio files arranged horizontally. 

This window where you can select the import 
method appears.

The audio files are loaded into 
Cubase LE tracks.

HINT
•	 Project data is stored in folders for each project 

in the PROJECT folder in the ZOOM_R8 folder. 
Audio recordings are stored as WAV files in 
the “AUDIO” subfolders of each project folder. 
Each AUDIO folder also contains a file called 
“PRJINFO.TXT” that lists the names of files 
assigned to tracks.

•	 Master tracks and stereo tracks are stereo  
WAV files. 

•	 To copy a WAV file from a computer, copy it to 
the AUDIO subfolder of the desired project folder 

Use the  to assign the files to tracks.
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Importing audio into Cubase LE 	

From the Cubase LE “File” menu 
select “Import” and “Audio File…”

The “Import Audio” window opens.

6

1 Connect the computer and the  
with a USB cable.

2 Press USB.

3 Select READER.  

Using the “Import” command

5 Open the Cubase LE project into 
which you want to import audio 
data.

Press ENTER.

コンピューターからR24を操作

Change 
menu

Access the  from the computer.

4 Launch Cubase LE.
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7 Select the desired audio file (or 
files) from the “AUDIO” folder of 
the project from which you wish 
to import. Click “Open.”

Importing files will cause the “Import Options” 
window to appear. 

8 In the “Import Options” window 
click the “Copy File(s) to Working 
Directory” check box, and click 
the OK button. 

When a file is imported, a 
window will open asking how 
Cubase LE should place the file.

When importing multiple files at 
one time, select either “Different 
Tracks” or “One Track” as the 
import method.

9
The audio data is assigned to one or more 
Cubase LE tracks. 

Generally, select “Different Tracks” 
to automatically create one track for 
each file. The files will be arranged 
vertically in the project window. 
Select “One track” to create one 
track with the audio files arranged 
horizontally.

HINT
•	 Project data is stored in folders for each project 

in the PROJECT folder in the ZOOM_R8 folder. 
Audio recordings are stored as WAV files in 
the “AUDIO” subfolders of each project folder. 
Each AUDIO folder also contains a file called 
“PRJINFO.TXT” that lists the names of files 
assigned to tracks.

•	 Master tracks and stereo tracks are stereo  
WAV files. 

•	 To copy a WAV file from a computer, copy it to 
the AUDIO subfolder of the desired project folder 

Use the  to assign the files to tracks.
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Mixer in audio interface mode 
In audio interface mode you can make a mix for monitoring using the  internal 
mixer. In addition, you can adjust the balance of the sound from the internal mixer and 
from the computer.

NOTE
The reverb send, pan, volume and stereo l ink  
set t ings are a l l  saved when you end (EXIT)  
audio interface mode and can be used again the 
next time.

You can be adjust the reverb send, pan, 
volume and stereo link settings in the same 
way as in recorder mode.
Operation is the same as in recorder mode.
(Reference: Operation Manual P.42)

PAN/EQ menu

VOLUME 
Adjust the volumes of INPUTS 1–2.

0–127 (increments of 1) 
Default value: 100

REV SEND
Adjust the reverb send levels of INPUTS 1–2.

0~100 (increments of 1)
Default value: 0
Reverb only affects the 
monitored signal (as in 
recording mode).

PAN (BALANCE)
Adjust the pan for INPUTS 1–2.

L100~R100  
(increments of 2)
Default value: Center
(as in recording mode)

Link INPUT 1 and 2 to handle them as stereo 
pairs.

On/Off
Default setting: Off
By setting up a stereo link, volume, reverb send and pan 
track parameters can be shared by INPUT 1 and 2.
(Reference: Operation Manual P.29)

Volume, reverb send, pan

Balance

In audio interface mode, the balance of the 
input monitoring signal and the signal from 
DAW software (the computer) can be adjusted 
with the BALANCE knob. 

Stereo link

Left

Only the INPUT 
1–2 signals

Right

Only the DAW 
stereo signal
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Tuner 
The  tuner can be used as when in audio interface mode. For details, see the 
Operation Manual (P.108). 

1 Press TOOL. 

Select TUNER. 2

Press 
ENTER.

Press ENTER.

Chromatic tuner 
TOOL > TUNER

4 To change the standard pitch, 

press the  beneath .

5 Select the standard pitch.

NOTE
Tuner settings are saved when you end (EXIT) au-
dio interface mode and can be used again the next 
time.

HINT
•	 The default value of the standard pitch is 440 Hz. 
•	 Tuners other than the chromatic tuner can also 

be used. 

Change 
menu

Change the 
standard pitch

Press ENTER.

4 To change the tuner type, press 

the  beneath .

5 Change the tuner type.

Change the 
tuner type

3 Tune the instrument.
☞ Reference:	Operation Manual 

		  Tuner P.108

☞ Reference:	Operation Manual 
		  Tuner P.108
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Effects in audio interface mode
The  insert and send-return effects can both be used when the sampling frequency 
is set to 44.1 kHz. Basic operation is the same but there are a few differences in the 
menus.

NOTE
•	 Effects can only be used when the sampling rate 

is 44.1 kHz. At all other times they are turned 
OFF.

• Insert and send return effect settings are saved 
when you end (EXIT) audio interface mode and 
can be used again the next time. 

Insert effect Send return effect 

As in recording mode, you can select the insert 
location and the insert effect algorithm, as 
well as the effect patches to be applied to the 
signal being recorded.

INSERT EFFECT menu options 

Select the insert location
Insert on any INPUT 1–2.

(Reference: Operation Manual P.45)

Apply the effect only to monitoring
The effect can be set to only be applied to the monitoring 
signal and to not affect signals recorded in DAW software.

(Reference: Operation Manual P.89)

When used as an audio interface, the send 
reverb can only be used for monitoring. 
As in recorder mode, use the SEND REVERB 
EFFECT menu to change the patch and use the 
PAN/EQ menu to set the REV SEND level that 
adjusts the reverb depth.

Setting the reverb send level

REVERB SEND
Adjust the amount of reverb using the REV 
SEND level of the PAN/EQ menu. 

(Reference: Operation Manual P.44)
(Reference: Audio interface manual – Mixer P.26)
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Working with patches
After making many changes, you can restore a patch to its pre-edited settings by 
initializing it. This will return it to its factory preset condition.

1 Press EFFECT.

Selecting effect type
Insert effect

Send return effect 

Patch initialization (factory reset)
EFFECT > INITIAL

Selecting patches
INSERT EFFECT/SEND REVERB 
Select a patch from an algorithm to use an 
insert or send reverb effect.
(Reference: Operation Manual P.83)

Editing patches (EDIT)

By adjusting effect module parameters and 
levels, you can create the desired result. 
(Reference: Operation Manual P.84)

Importing patches (IMPORT)

All effect algorithms (and reverb patches) or 
a single one can be imported from a selected 
project on the . 
(Reference: Operation Manual P.87)

In audio interface mode, one complete set of effect 
data is saved for the mode. There are no project 
based settings.

Saving patches (SAVE)
Edited patches can be saved.
(Reference: Operation Manual P.86)

Initializing patches (INITIAL)
Patches can be restored to their original fac-
tory settings. (This option is only available in 
audio interface mode.)

Changing patch names (RENAME)
The name of the currently selected patch can 
be changed.
(Reference: Operation Manual P.88)

Menus used for patch operations 

Patch operations
For both insert and send return effects 

The following example is of an insert 
effect. 

Press the  beneath .

Press the  beneath .

Turn the effect On.2

Select INITIAL.3

Press ENTER.

Change 
menu

4 Select YES. 

Press ENTER. 

Change 
menu

Change
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Control surface setup for other DAWs
You can set up the  as a controller for use with a variety of DAW software besides 
Cubase LE. Please refer to the manual for the software that you are using.

Logic

Control surface setup Function key setup

Select “Preferences” > 
“Control surfaces” > “Setup…”  
from the “Logic Pro” menu.

This opens the “Setup” window.

Click on the top left “New” and 
select “Install” from the pull-down 
menu.

Select “Mackie Designs/Mackie 
Control/Logic Control” from the list 
in the “Install” window and click 
the “Add” button.

“Mackie Control” will be added to 
the setup window.

Click the “Mackie Control” icon. 
Then, from the top of the list at the 
left set “Out Port” and “Input” to 
“ZOOM R8” using their pull-down 
menus.

Select “Preferences” > 
“Control surface” > “Controller 
Assignments…” from the “Logic 
Pro” menu.

This opens the “Controller 
Assignments” window.

From the “Zone” column select 
“Control Surface: Mackie Control.” 

Change the functions as you like. 
Controls F1–F5 correspond to the 
F1–F5 keys on the .

The above procedures are for Logic 
Pro 9.

The names of the menus, for 
example, might be different in a 
different version of Logic.

Please refer to the manual for the 
version of Logic that you are using 
for details.

1 1

3 3

4

2
2
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SONAR

Control surface setup Function key setup

Select “Controller/Surface” from 
the “Options” menu to open the 
“Controller/Surface” window.

Click the “Add” button and open 
the “Controller/Surface Settings” 
window.

Choose “ZOOM R Series” from the 
drop-down menu of the “Controller/
surface” column.

Select “ZOOM R8” in the input/
output port column.

For Cakewalk SONAR, installation 
of a control surface plug-in is 
necessary. Please install it when 
installing the driver.

Open the “Edit” > “Preferences” 
menu.

Click “Customization”.

Click “Key bindings”.

Click “Locate Key…”

Press the F1-F5 key that you 
want to setup to see the currently 
assigned function. Change that 
function as necessary.

The above procedures are for 
Sonar X1.

The names of the menus, for 
example, might be different in a 
different version of Sonar.

Please refer to the manual for the 
version of Sonar that you are using 
for details. 

1 1

3
3
4
5

2 2
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Control surface setup for other DAWs

Ableton Live

Control surface setup Function key setup

Select “Preferences” from the 
“Option” (Windows) or “Live” (Mac) 
menu. 

The Preferences window will open.

Click the “MIDI” setting tab on the 
left side of Preferences window to 
select it. 

The setup window related to MIDI 
will open.

Select “Mackie Control” in the pull-
down menu of the Control Surface 
column.

Select “ZOOM R8” from the pull-
down menus of the Input and 
Output columns for both left and 
right.

In the MIDI Ports section below, 
turn “On” the Remote column 
button for the “Input: Mackie 
Control Input (Zoom R8)” item.

Press the MIDI button at the top 
right of the main LIVE window to 
start MIDI map mode. 

Interface elements that can be 
assigned will be highlighted in blue. 
Click on a parameter that you want 
to control.

Press the F1–F5 key of the  
that you want to assign to control 
the selected parameter.

The above procedures are for 
Ableton Live 8.

The names of the menus, for 
example, might be different in a 
different version of Live.

Please refer to the manual for the 
version of Live that you are using for 
details.

1 1

3

3

4

5

2 2
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Digital Performer

Control surface setup

Launch the Audio MIDI Setup 
application (/Applications/Utilities).

Open the MIDI Studio window 
(Window > MIDI Studio) and 
confirm that “R8” is displayed.

Click “Add Device.” 
A “new external device” will be 
added.

Click the “new external device” to 
select it, and then click the “Show 
Info” button.

Enter the name “R8” in the “Device 
Name” field.

Click and drag the downward 
arrow of the original “R8” icon and 
connect it to the downward arrow 
of the “R8” icon that you added. 
Use same method to connect the 
upward arrows.

Launch Digital Performer

Select “Control Surface Setup” 
from the “Setup” menu to open the 
Control Surface window.

1

9

10

11

123

4

5

6

7
8

2

Click the “+” icon in the Control 
Surface window and select “Mackie 
Control” from the “Driver” pull-
down menu.

Select “Mackie Control” from the 
“Unit” pull-down menu that will be 
displayed at bottom.

Select “R8” from the “MIDI” pull-
down menu of the Control Surface 
window and select “R8-1” from the 
menu list.

Click the “OK” button.

The above procedures are for Mac 
OS X 10.6 and Digital Performer 7.

The names of the menus, for 
example, might be different in a 
different version of Digital Performer.

Please refer to the manual for the 
version of Digital Performer that you 
are using for details.

The functions are already assigned in Digital Performer 
and cannot be changed.

AUTO PUNCH I/O key: 	 Selects YES in dialog boxes
A-B REPEAT key:	 Selects NO in dialog boxes

 (marker) key:	 Creates groups/track groups
 (marker) key:	 No assignment

MARK/CLEAR key: 	 No assignment

Refer to sections about Mackie Control dialog boxes 
and track groups in the manual for the version of Digital 
Performer that you are using.
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1

2 Press

Connect the  and the computer by 
USB cable.  Then, turn the power ON.

NOTE

●● When using Windows or Mac OS X 10.6.5, 
use the default setting of UAC2.0.

HINT

●● The USB Audio Class is a specification 
for audio devices connected by USB and 
includes UAC1.0 and 2.0. UAC2.0 allows 
transfer at Hi-Speed (480 Mbps) mode, 
which reduces latency.

Setting the audio class

Using the R8 with Mac OS X 10.5.8 
If noise should occur when using the  as an audio interface with Mac OS X 10.5.8, follow the 
procedures below to change the audio class setting.

Select AUDIO I/F.3
Change menu

Press

4 Select CLASS and set it to UAC1.0. 
Change menu

Press

Select EXECUTE.5 Change menu

Icon appears when 
connection is made.

Audio interface mode is enabled.6

Change setting 



To continue using Cubase LE, it is necessary to have a User Registration 

and a Software License Authentication. The Registration and 

Authentication can be processed when Cubase LE is activated on a 

computer connected to the Internet. Click “Register now” which is shown 

when activating, and enter all the items. If registration is not recognized, 

Cubase LE can only be used for a limited period after installation.

From the SD card supplied with the           open
Drivers > Windows > 32bit (or 64bit) and launch
“Setup.exe”

OR

Download the latest “ZOOM R8 Audio Driver” from 
the ZOOM website (http://www.zoom.co.jp)
and install it on a computer.

The ZOOM R8 Audio Driver software is required to enable audio 
input and output with a computer when using Cubase LE. Refer to 
the "R8 Driver Installation Guide_Windows.pdf" included in the 
download package for instructions on how to install the driver 
correctly.

32bit folder: Windows® XP SP3 or later (32bit), Windows® Vista 
SP1 or later (32bit), Windows® 7 or later (32bit)
64bit folder: Windows® Vista SP1 or later (64bit), Windows® 7 or 
later (64bit)

How to install the driver
Double-click the Setup.exe file to activate the installer.

Continued overleaf

Cubase LE Startup Guide R8-E-1

Cubase LE Startup Guide

This Cubase LE Startup Guide explains how to install Cubase LE on a computer and make connections and other settings for the         .Windows

To connect the          to a computer running Windows 7 (or 
Windows Vista or XP) and to enable audio input/output, 
proceed as follows. This installation description uses 
Windows 7 as an example.

Insert the supplied Cubase LE installation 
DVD-ROM into the DVD drive of the computer.

When you insert the DVD-ROM, a screen asking what you want to 
do appears. Select "Cubase_LE_5_Start_Center.exe". A language 
selection screen will appear. Select your language, and then follow 
the on-screen prompts.

• Windows 7/Vista 
When you connect the          to a computer, an "Installing device 
driver software" message appears. When the software installation 
completes, "The device driver software installed correctly" 
message appears. 

• Windows XP
When you connect the        to a computer, a "Found New 
Hardware ZOOM R8 Audio Interface" message appears. 

Wait until "The device was able to be prepared" message is 
displayed. 

Click “Next” to start 
installation.

Se lec t  “ Ins ta l l  the  
SONAR Plug-in” to 
enable use of control 
surface functions with 
SONAR.

Click “Install” to start 
installation.

Click “Finish” to finish 
installation.

If nothing happens when you insert the DVD-ROM, open the Start menu 

and select “Computer” (“My Computer” in Windows XP). Then 

double-click the “Cubase LE 5” DVD-ROM icon to display the contents of 

the DVD-ROM.

  NOTE

  NOTE

We recommend you upgrade the       system software to the latest 

version. An         operated with an old system might not be recognized 

correctly. The latest system version can be downloaded from our 

website (http:/www.zoom.co.jp).

  NOTE
Use a high-quality USB cable and keep the connection as short as 

possible. If USB bus power is supplied to the          via a USB cable 

that is more than 3 meters in length, a low voltage warning might 

appear.

Choose the language 
and click [OK].

Connect the          to the computer using a USB 
cable and enable use as an audio interface.

Audio interface is enabled.

Select AUDIO I/F.

Press3

6

How to connect the          as an audio interface 

   Select the language 

   Start InstallShield Wizard 

   Driver and Plug-in selection 

   Ready to install the driver

When a “Windows security” warning message appears, click “Install”.

   InstallShield Wizard completes 

DAW software
Cubase LE, etc.

Windows PC

USB cable

PHONES jack
Audio system, 
headphones or other 
playback equipment

OUTPUT jacks
Audio components, 
speakers with built-in 
amplification, etc.

INPUT jack
Guitar, other instrument
or built-in stereo mic

Audio Driver

If an “Install hardware” warning dialogue appears, click “Continue”.

Open the “Sound” window from the Control Panel 
and make the input device setting for the 
computer.

To open the “Sound” window, select “Control Panel” from the Start 
menu and click “Hardware and Sound”, then click “Sound”.

In the “Sound” window, verify that “ZOOM R8 Audio Interface” is 
listed under Playback and Recording devices and is checked. (To 
switch between Playback and Recording, click the tabs at the top 
of the window.)
If “ZOOM R8 Audio Interface” is not checked, right-click on the 
icon for the device and click “Set as Default Device” so that a 
check mark appears.

  HINT

Select EXECUTE.

Press
5

Connect the           to the computer using 
a USB cable. Turn the power ON.1

2 Press

Change menu

Change setting 

Select CLASS and set it to UAC2.0.4

Change menu

USB icon appears when connection completes.

Change menu

 



When the connection is enabled on the       , it should be 
recognized by the computer.

Open the “Applications” folder and then the 
“Utilities” subfolder, and double-click “Audio MIDI 
Setup”.

The Audio MIDI Setup screen appears. Open “Audio Devices” 
(Window > Show Audio Window) and check that “ZOOM R8 
Driver” is selected as the default input and default output.

If another device is selected, use the gear icon (or right-click) to 
change the selection to “ZOOM R8 Driver”.
After the settings are made, close Audio MIDI Setup.

Start Cubase LE. Then, access the “Devices” 
menu, select “Device Setup...” and click “VST 
Audio System”.

To start Cubase LE, double-click the Cubase LE icon in the 
“Applications” folder.
After startup, confirm that “ZOOM R8 Driver” is selected in the 
right section of the Device Setup window.

Start Cubase LE. Then, open the “Devices” menu, 
select “Device Setup...” and click “VST Audio 
System”.

To start Cubase LE, double-click the Cubase LE shortcut icon 
that was created on the desktop. 
After startup, select “ZOOM R8 ASIO Driver” as the ASIO driver 
in the right section of the Device Setup window. When you 
change the ASIO driver selection, a confirmation message 
appears. Click the “Switch” button.

The device indication in the left section of the window now 
shows “ZOOM R8 ASIO Driver” as the ASIO driver.
Click on this indication to select it, and then click the “Control 
Panel” button in the right section of the Device Setup window.

The window that appears lets you set the buffer size for the ASIO 
driver. The buffer size should be set to a value that is as low as 
possible without causing sound dropouts during recording and 
playback. 
The sampling frequency can be changed in the Cubase LE 
Project Settings.

When these settings are complete, click the OK buttons in the 
respective windows to close them and restore the Cubase LE 
window to its appearance at startup.

From the “Devices” menu of Cubase LE, select 
“VST Connections”. In the window displayed, set 
“Input channel-1” and “Input channel-2” as the 
input ports and “Output channel-1” and “Output 
channel-2” as the output ports .

Use the tabs at the top left to switch between input and output, and 
verify that “Input channel - 1”, “Input channel - 2”, “Output channel - 1” 
and “Output channel - 2” are selected as the device ports. 
If another device is selected, click the device port field and change the 
selection.

Insert the supplied Cubase LE installation DVD-ROM 
into the DVD drive of the Mac and start installation.

The contents of the DVD-ROM should be shown automatically. If 
they are not shown, double-click the “Cubase LE 5” icon 
displayed on the desktop (or in a Finder window).
When it appears, use the Cubase LE 5 
Start Center to install the application. 

Continued from front Windows This Cubase LE Startup Guide explains how to install Cubase LE on a computer and make connections and other settings for the         .Mac OS X

  NOTE
Use a high-quality USB cable and keep the connection as short as 

possible. If USB bus power is supplied to the         via a USB cable 

which is more than 3 meters in length, a low voltage warning might 

appear.

To connect the          to a computer running Mac OS X and 
to enable audio input/output, proceed as follows.
This installation description uses Mac OS X v10.6.5 as an 
example.

Connect the          to the Macintosh using a USB 
cable and enable use as an audio interface.

Select AUDIO I/F.

Press

Press

2
3

Select EXECUTE.5

Press

How to connect the          as an audio interface 

Optimizing performance

While using Cubase LE, other applications might slow down drastically 
or a message such as “Cannot synchronize with USB audio interface” 
could appear. If this happens frequently, consider taking the following 
steps to optimize the operation conditions for Cubase LE.

1) Shut down other applications besides Cubase LE.
In particular, check for software and utilities running in the background.

2) Reduce the number of plug-ins 
 (effects, instruments) used by Cubase LE.
When a large number of plug-ins is used, the computer's processing 
power may not be able to keep up. Reducing the number of 
simultaneous playback tracks  can also be helpful.

Adjust the latency (Devices menu) if the sound cuts out. See 
step 5 (for Windows) in this Startup Guide for details.

If applications still run very slowly or the computer itself does 
not function properly, disconnect the         from the computer 
and shut down Cubase LE. Then, reconnect the USB cable 
and start Cubase LE again.

DAW software
Cubase LE, etc.

USB cable

PHONES jack
Audio system, 
headphones or other 
playback equipment

OUTPUT jacks
Audio components, 
speakers with built-in 
amplification, etc.

INPUT jack
Guitar, other instrument 
or built-in stereo mic

Macintosh

If another device is selected, use the pull-down menu to change 
the selection to “ZOOM R8 Driver”.
After the setting is made, click “OK” and close the window.

From the “Devices” menu of Cubase LE, select 
“VST Connections” and select “ZOOM R8 Driver” as 
the Audio Device for both the input and output 
ports.

Use the tabs at top center to switch between inputs and outputs, 
and verify that in the as Device Port column “ZOOM R8 Driver L/R” 
is selected for the Inputs and “ZOOM R8 Driver 1/2” is selected for 
the Outputs.
If another device is selected, click the Device Port field and change 
the selection.

1 Connect the          to the Macintosh using 

a USB cable. Turn the power ON.

Change menu

Select CLASS.4

Mac OS X 10.5.8: Set to UAC1.0
Mac OS X 10.6.5 or later: Set to UAC2.0

Change setting 

Change menu

Change menu

Audio interface is enabled.6
USB icon appears when connection completes.

ASIO Driver

…then, click this button.Click here…
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